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Productivity Matters

(|

productmty

noun pro-duc-tivii-ty | \ pro-dek-'ti-ve-té, pra-, pre- dak-\

noun

1. the quality, state, or fact of being able to generate, create, enhance,
or bring forth goods and services:
The productivity of the group's effort surprised everyone.

2. Economics. the rate at which goods and services having exchange
value are brought forth or produced :
Productivity increased dramatically last year.
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Productivity Matters

0 Time /Distraction Management
0 Office Productivity
0 Productivity Enhancers <

01 Email Productivity

Time /Distraction Matters

0 Eliminate computer distractions:

o Pop-ups

0 Smartphone Notifications This is a
o Social media feeds POp-uUp
o SPAM and BACN distraction!

o Monitor placement
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Time /Distraction Matters

0 Losing focus and concentration
o Digital world reducing concentration
o Harder to get long-term tasks completed

o Try the Pomodoro technique

Productivity Matters

0 Helpful Apps
o PomoToDo: Helps with PT
£ RescueTime: finds lost time
o StayFocusd: Chrome extension

0 Freedom: Blocks the Internet
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Office Productivity Matters

1 Phone Calls
1 Return calls in scheduled

blocks of time

o Leverage voice mail
® Inbound
m Outbound

Office Productivity Matters

0 Calendar “hard” and “soft” tasks

o Hard = court hearings, discovery
dates, client appointments, etc.

o Soft = marketing activities, billing,
process improvement, thinking time
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Office Productivity Matters

o Optimize your workspace
o De-clutter workspaces
0 Reduce desktop storage

o Increase nearby file storage

Office Productivity Matters

o Optimize computing space
o1 Dual monitors

0 Adjust settings
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Office Productivity Matters

0 Optimize file storage
O Paper
m Color code
m Consistent organization
o Digital
m Consistent organization
m Similar to paper

Productivity Matters

0 Increase productivity by reducing risk
o Evaluate the costs and benefits of each new client

o Learn to say “no”
0 Increase efficiency (doing things right)
01 Delegate. Repeat.

1 Document unbillable time




11/7/2018

Productivity Matters

0 Embrace practice management software

PRACTICEPANTHER 20l0suITE & L—L

4y mycase ocketmatter =
v ﬁuo Cismolex

\@pMerusCase

ice Management Simplified

Goodnight, PDF

0 Have Adobe Acrobat read your document to you
0 View>ReadOutLoud>Activate
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Affordable Video Conferencing

Zoom Video
WWW.Zoom.us
* Up to 25 Participants
* Unlimited meetings
* Recordings

* Screen-sharing

* iPad / iPhone apps
* $9.99/month

Give Your Office a Stress-Reducing Makeover

0 Poor lighting = eyestrain
01 Excess noise = Distraction/Frustration
0 Poorly positioned computer = trouble

0 Add a water cooler for better health
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Office Productivity Matters

01 Mobile Business Apps
o IFTTT
o Zapier

IFTTT.com

Convert an e-mail
to event in Google
Calendar

by mackuz

& 3.5k works with

=

If any new SMS
received, then
send an email to
gmail

by jplanas

Quickly email a
photo to yourself
or others

by jamisonross

£ 8.9k

N1

| G

Send an SMS when
an email is

received with a
specific subject

by egresssystems
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Lapier
M @ @ =

Gmail Trello Google Calendar Slack

Copy file to Dropbox or create a text file
for each new Google Document

his Zap

# Popular Zap Used

# Popular Zap Use

e =\ v

MailChimp Typeform Twitter

Create Google Doc file from Solid
meeting's notes

E
e this Zap

Save New Evernote Notes to Google D|

Office Productivity Matters

01 Online credit card acceptance

o Let the client do the work

0 Secure payments

10
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0 Get regular exercise

0 Practice good nutrition

0 Impose a quitting time

0 Take a real break at lunch

1 Have an office make-over

Office Productivity Matters
|
[1 Remote access
technology LOQMG@
0 Work on your office
computer from anywhere GoloMyPC
0 Affordable and secure %
Microsoft Remote Desktop
Productivity Enhancers
|

11
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Email Productivity

0 The McKinsey Global Institute: Average U.S. worker
spends 13 hours a week reading and responding to
email.

0 According to SaneBox, the average inbox contains
only 38% important, relevant emails.

0 Danwood Group study: Takes an average of 64
seconds to recover/refocus from an email interruption,
regardless of the email’s importance.

Email is not your job!

0 Have a strategy

0 It’s not about the technology, but about human
behavior

0 All email is not created equal

01 Choose the tactics and tools that work for you

12
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The Different Types of Email
-*
Urgent and Important but not
important urgent
112
3|4
Urgent but not Not urgent and
important not important
Source: Dwight D. Eisenhower/Stephen R. Covey

Email Productivity
[

0 Prevent unimportant emails from getting to your
Inbox

o Deal with SPAM
o Unsubscribe from BACN
o1 Divert to subfolders using Rules )

13
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Turn off Outlook Notifications

I = H e |
@Dptlons
Shortcuts
» General Message options
- Mail After moving or deleting an item | Returm ta the view
A

Automatic replies

Email Productivity

0 Schedule several blocks of time each day to review
your email
o Don’t have your Inbox on screen all day

o During each session have a disciplined approach to
review and react to each email

14
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Triage Tactics
AN .,

01 Scan and delete unwanted emails

0 Read, then file or delete if no reply needed
0 Delegate /Forward to others to respond

0 Do the ones that will take 2 minutes or less

1 Defer the ones that need more attention
1 Move to an Action folder; or

1 Create a reminder or task

Email Productivity
- T

01 Reorder how you create an email to be more
productive:
o Add the attachments first
o Create the body of the message
o Add a succinct subject line

0 Add recipients

15
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Email Productivity

|

Email Tools

] Microsoft*
Y- Outlook

Microsoft
Outlook 2016

J Office 365

16
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Outlook Rules

0 Allows you to auto-sort your incoming emaiil
(among other things)

1 2010: File menu > Info > Rules and Alerts

0 365: Settings>Options>Mail>Inbox and sweep
rules

0 Gmail: Settings>Filters>Create a filter

Inbox Cleanup Tools

1 Mailstrom

Clean Up Your Inbox Now.

Inbex zero is now within reach! Power through thousands of messages in just a few clicks.

0 The Email Game

1 Unroll.me

0 Sanebox /»é,,,,,,wgm
emailga.me

17
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Sanebox

SaneBox automates email chores

We prioritize your Inbox and let you know if an email didn't receive a reply.

We can also sort your Inbox, keep track of reminders and snoozed emails, rescue real email
from your spam folder, upload attachments to your cloud, and more...

Sanelater

We think these emails can wait.

Q

SaneReminders

Set email reminders for your future self.

)

SaneNews

Al of your mailing lists and newsletters in
one place,

=3

SaneBlackHole

Easily train mailing lists and individual

ko)

SaneSnooze

Defer an email until tomorrow, next week,

senders to your trash folder. next month, or any time.

& ®

SaneAttachments SaneMNoReplies

Say goodbye to bulky attachments and
hello to automatic uploads to the cloud.

=

Custom training

Quickly see all deadbeats that didn't reply
to your emails.

SaneNotSpam

Create your own custom SaneBox folders. Rescue real email from your Spam folder.

D @

Home Send / Receive

Clean Up Conversations

Folder Wiew

& Email2Task

3 Rese

i Ignore x

;_a 3 :_f% B8l Meeting |5y Forward to me

%= Clean Up ~ B - & Forward to: All PPC 33 New e-mail to: all ... [2} Mov

New New Delete Reply Reply Forward ~ ; &
E-mail Ttems - | @ Junk 2l B, More - | | Addto Calendar &5 Forward to: PRC 23 Rese

Mew Delete Respond Quick Steps

<
4l Favorites
Search APRL (Ctrl+E »r -
e e | Re: [APRL] Admiss
EESTMAS NS G0 Arrange By: Date |Newest on top i

4 .PMA List (557)

@ .Excom (430)

4 RTrautz@aila.org
A [ Inbox (2263)
3 .ARTESIA OTG (318)
3 .BOG (134)
A -Excom (430)
- C3 .PMA List (567)
3 @waiting
3 Administrative Matters (17)
|- 3 Answered Requests (3)
> 3 APRL (2118)

3 Attorney Resources

Mary Grace Guzn

=1 Charles Lundberg 6/30/2016
Re: [APRL] Question a Sentt Wed 6/29/2016 4:38 P
51 Bob Brain 6/30/2016 15 Kim Ringler
— [APRL] Question Listserv APRL
1 Mark Tuft 6/30/2016 1 Message "L PastedGrap

Re: [APRL] the proposed California rul... "]

Clean Up Conversation

T

-

All redundant messages in this
conversation will be moved to the "Deleted
Ttems" folder.

|| Do not show this message again

LoDEl]

6/29/2016
1}

Cacoc for

My experience in C
complexity of the is

CA does not have a
longer) if they get p

~mary grace

On Jun 29, 2
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Office 365

Mew Mewr
Email Items~

Mew

B=

SEMD f RECEIVE

FOLDER

—

—

= S =

>t

Clean Up -

= Clean Up Conwversation

LN Y

Clean Up Folder

I

[ =R

Clean Up Folder & Subfolders

e

All redundant messages in the current folder will be moved to
the "Deleted ltems” folder.

|:| Don't show this message again

| Settings || Clean Up Folder || Cancel

QuickSteps

] 15 MinImpt Task
) Task w/ Email
E Appt w/ Text

{5 ToRead (34 Newto Partners ) Newto GSD

Gy Reply & Delete (3§ Reply & Move L2 Move

21 Task w/ Text X Delete message % Appt w/ Email
Quick Steps

v

v
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QuickSteps

Edit Quick Step

Add actions below that will be performed when this quick step is dicked on.

=

Mame:
15 Min Impt Task |

Actions

|@ Create a task with attachment

X %

E Categorize message

‘D 1-Less than 15

| ? Setimportance

‘ ¥ Importance: High

|>< Delete message

|

Optional |
Shortcut key: | Choose a shorteut n |

Tooltip text: ‘ |

. Crsn J [cnd ]

Outlook Flags & Gmail Stars

—— = . ——

Waien dngie-dicking on the Flags
column, add the folowing fag:

) & ST
| W | Today
l: L' Fn'n.nf.rnw
' Ths Wesk i
o Mexl Wesk
¥  MoDate
+  Compiete

Settings
General Labels Inbox Accounts and Import Filters and Blocked Addre
Chat Labs Offline Themes

Send and Archive:
Learn more

Show “Send & Archive” button in reply
= Hide "Send & Archive” button in reply
Undo Send: ! Enable Undo Send . .

Send cancellation period: | 10 ¥ | seconds

Preview Pane:

3 conversation as read: | After 3

Stars:

Presets: 1 star 4 stars all stars
In use: w K N K
Notinuse: W [ ! H = =

Drag the stars between the lists. The stars will rotate |
successively. To leam the name of a star for search, hover
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Outlook Categories

TFormat Tea Haviea

abicty | Geneal Detads

Dan Pinnington - Contact

84 Actarties
&1 Conates

N riekde

| Refesral purce
Fisl Mape.
Comgany:
ek frie
Filg s
et
W Emad

sy as

et page addreas

Phand numbers

Businest

[rmpr——
Lawyers Profisional incamnaty
Ewrestor.

Pinningice, Dan

RanPusngive@lramese

e Dunclar Street
Torortn Omane NSO 123
Canscls

| Dan Pinningron

Fiimeet Chent

Sorparabar

(e @ aF

w | Cotegorisn Folion Privaty  Update
- ey

Clear A1 Catwguries o
Perthutay

P

Chant

ConferancenTravel

Crwctons esting

Leeem

Sarmar Clhnt

Halidey Card Ut

B Comm

Convert Outlook Email and Folders to PDF

< 2B~ - GPsolo Division - Microsoft Outlook
File Edit Wiew Go Tools Actions Help Adobe PDF
bew ~ | XK | CEeply @ Reply to [ Forward SendsReceive -
= (8 convert folder(sytopor 3|8
Ihsert Activity | SyncTasks  Import Appo
Flease select one or more Folders to create PDF From, _
Mail ch AE.
= =[] Archive Folders -l F—
[Fertenliz FEe =[] Mailbox - Makalie Kelly
[ Zjmbox [32] [ anaTesting Hl=ws
L Unread pdait 21 aBa for th
L[5 sentItems ABA - GPSolo Division al Diff
PAail Folders [C] ABA - LPM Section ible fo
_ -] aBA Site-tation
£ ANl Mail tems -0 ALS and AALS For the
= 5T Mailbox - Matalie Kelly [ apple GPsal
[ staTesting [ Bar Depts ble fo
= 3 ABA [11) [ Bulletin Board - SBG Boards Prem.
[ ABA - GPSolo ion [9] [] cabinet ing Re
= 3 ABA - LPM Section [7) Calendar
e e o a rer Contacts trent
& T % Celeted Items pa (B
Documents Com
..... [ Drafts GPSol
Hcaco o [ GABWA- Gate City Bar 2 ABA
82| contacts [ Inbox Jid [ =i
- I Convert this Folder and all sub Folders g De
E Tasks
OK I Cancel I .
| motes ipiE.

u
.

Click here to download pictures. To help protect your privac,

Arvnmlomd ~F carne mickiees im b
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- Open as many
Outlook ‘Modules’ as
you want

- Right Click, Choose
Open in New Window

One Not Enough?

Administrative Matters (16
Answered Requests (3
APRL (2116)

ARTESIA OTG (94

Attorney Resources

BACN (45)

CARA Project

Chapter Newsletters (10

MWW NUWNNVL

‘j Cele 5  Open in New Window

8| Conmt Nayigation Pane Options..

' Tasks

wl G2 (3

Comphments v

18

TMG's Take...on Lawyer Bu!
Cirque Club
#0OVO pre-sale starts now
Eve Runyon
Reminder: Pro Bono Partne

DMS Team - Affinity Con
Your Worldox Newsletter fi

Sheryl Cline

WHAT'S SLOWING YOU DC
Sheryl Cline

KEEP THE FIRE BURNING
Sheryl Cline

CALVARY WAS ALWAYS PA|
vsbinfo

Annual Meeting Registratio
Sheryl Cline

PRECIOUS BLOOD—PRECIC
Sheryl Cline

THE BEAUTY OF THE BREA®
SurveyMonkey

Scanner Pro (iOS) - $6.99

EHinmn

ATE
VO
MBA repair AN
CCOI -
XRRK KHXNNK X4567
IMP PRODLCT _ 8
PB]J REG

1
EX
i

G

§4.099
GALLONS  FUEL JOTAL
’{3.543 § 35.51

ANK YOU
COIEE‘BACK SOON

$6.99

Turn Your Phone Into a Scanner

Genius Scan (Android) -
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Security Matters

h

o
8 danger m:lé‘ept
private sign firewall

oPadlock lock equlpment
+ display commumcatlon

m connection surveilla

Securit y

1?&’:;‘2 £ prgteﬁlo
E s egu r

identity
pr:vacy a
3 u%f*

weh
inte
monitori
softwar

Security Matters R e it gg

connecﬁon surveillance

gﬁ

Aaccess

0 Training partners & employees “‘*jgjgpr?ﬁf:mn“ég
0 Backup and disaster recovery i

0 Securing laptops, smartphones and mobile devices
01 Authentication and access control

0 Encryption of stored and transmitted data

01 Wireless network security

0 Security considerations in hiring & firing employees

23
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Evolving Security Precautions
[

0 Staying ahead of the criminals
0 Security standards change

01 Rule 1.1-Competence

Top Two Threats to Your Practice
AN .,

0 Phishing /Spear Phishing 0 Ransomware

o Access to sensitive info o Paralyzing virus locks
disguising as trusted all files
entity or person 0 Extorts money in

0 Requires training people exchange for files

to recognize

o0 Hardening resistance

24
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Training Partners & Employees

0 Continuing Education
0 Usage Policies

0 Anti-virus /Security Updates
0 Confidentiality Agreements

0 Testing /Tempting

Backup & Disaster Recovery
[

0 Automatic back-up software

0 Large & reliable local
storage device

o Off-site storage service

o Competent person to ensure it
works

25
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who I|kely will continue to target an organlzatlon While
the FBI does not advocate paying a ransom, there is an

understanding that when businesses are faced with an

inability to function, executives will evaluate all options to

protect their shareholders, employees, and customers.
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Top Two Threats to Your Practice
[

0 When infected with Ransomware:
Consult your IT professional

Check your latest back-up

Check whether all files encrypted

Choose a convermnt payment method:
Bitcoin (most cheap option)

Check NoMoreRansom.org bitcoin

Consult Bitcoin buying guide

26
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Securing Mobile Devices

0 Each laptop, tablet,
and smartphone is an
unlocked door into
your office

0 Security matters!

Securing Mobile Devices

0 Password Protection
0 Must be engaged
0 8-12 character phrases

0 Two-factor Authentication
o Device registration

0 Biometrics

27
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Encryption

1 Stored data
1 In-transit data

0 Garbles words/unreadable

Securing Internet Accounts
[

0 Strong passwords on
all online accounts

Username | erna _]

Password | =+

0 Don’t duplicate

1 Use Password
Managers

28
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Cloud Security Precautions
AN .,

0 Read Terms of Service
0 Know your rights

o Data breach

o Data ownership

o Data recovery

0 Strong passwords

Secure Remote Access-VPN
0 Access your office |
computer from anywhere LOQMG@

(with Internet)

SwnneclBcan

GoToMyPC

@ Hotspot Shield

29
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Wireless Network Connectivity

0 Unsecured Wi-Fi
ivnmenncllfcar networks are unsecure
o0 No password, no
@ Hotspot Shield connection!

1 Use VPN to connect

Personnel Matters

0 Integrating security into the
on-boarding process

0 Integrating security into the
exiting process

0 Vendors/Contractors

30
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Evolving Security Precautions

1 USB thumb drives

0 Metadata P twutber"@
0 Social media nue. ‘:,E]
You ube
l .m .m

QUESTIONS?

PRESENTED BY DAN PINNINGTON & REID TRAUTZ
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